
How to Convert a Metric Drawing to Imperial in
AutoCAD? (Step by step)

Description

AutoCAD, a leading design software, offers the flexibility to work in both metric and imperial systems.
However, the conversion between these two can seem complex for many users. This comprehensive
guide aims to make this process simpler by outlining the method to convert a metric drawing to imperial
in AutoCAD.

Key Takeaways

AutoCAD allows for efficient conversion between metric and imperial units.
This process involves using the SCALE command and adjusting the drawing units in the software.
Remember to save a copy of your original drawing before starting the conversion.
Post-conversion, it is crucial to verify the accuracy of dimensions and adjust the properties of
elements like text, dimensions, and hatch patterns.

How to Convert a Metric Drawing to Imperial in AutoCAD

AutoCAD, an industry-leading software from Autodesk, is an integral part of many design, architectural,
and engineering processes worldwide. One essential feature of AutoCAD is the ability to work in both
metric and imperial measurement systems. However, switching between the two can be a bit tricky if
you are not familiar with the process. In this comprehensive guide, we’ll walk you through the entire
process of converting a metric drawing to imperial in AutoCAD.

Understand the Need for Conversion

Before diving into the specifics, let’s understand the necessity for converting a metric drawing to
imperial. Two primary measurement systems are used across the world, metric and imperial. While the
metric system is standard in most places, the imperial system is predominantly used in the United
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States. If you work with collaborators from different parts of the world, converting drawings between
these two systems is a common requirement.

Step-by-step Guide to Convert a Metric Drawing to Imperial

Step 1: Open Your Metric Drawing

First, you will need to open your metric drawing in AutoCAD. Do this by selecting the “Open” option
from the “File” menu.

Step 2: Use the SCALE Command

The SCALE command in AutoCAD allows you to resize your drawing. In the case of converting metric
to imperial, you will use this command to scale down your drawing because 1 unit in a metric drawing
corresponds to 1 millimeter, whereas in an imperial drawing, 1 unit corresponds to 1 inch. Since 1 inch
equals approximately 25.4 millimeters, you will scale down your drawing by a factor of 1/25.4.

You can use the SCALE command as follows:

Type SCALE in the command line and press Enter.
Select the entire drawing (use CTRL+A or type ALL), then press Enter.
When prompted for a base point, you can click anywhere in the drawing area. This base point is
only a reference point for the scaling operation and does not impact the drawing.
When prompted for a scale factor, enter 1/25.4, then press Enter.

Step 3: Update Drawing Units

Now that you have scaled your drawing, it is essential to update the drawing units to reflect the change
from metric to imperial. You can do this using the UNITS command:

Type UNITS in the command line and press Enter.
In the Units dialog box that opens, select “Inches” under the “Length” section.
Click “OK” to close the dialog box and apply the changes.

Step 4: Save Your Drawing

After completing the above steps, your metric drawing is now effectively an imperial drawing. It’s critical
to save your work. Go to the “File” menu and click “Save As” to save your drawing under a new name
to avoid overwriting the original metric drawing.

Precautions While Converting a Metric Drawing to Imperial

Converting a metric drawing to an imperial drawing in AutoCAD is a straightforward process. However,
there are a few precautions to keep in mind:

Always save a copy of your original metric drawing before starting the conversion process. This
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ensures that you have a backup in case something goes wrong.
Check all dimensions in your drawing after the conversion. This can help catch any errors that
may have occurred during the process.
Remember that not just the geometry but also text, dimensions, hatch patterns, and line
thicknesses are scaled. Ensure they are readable and correctly represented post-conversion.

For a more visual guide to this process, you may want to refer to Autodesk’s official AutoCAD tutorial 
videos.

Managing AutoCAD’s Default Measurement System

AutoCAD doesn’t natively distinguish between metric and imperial units, but uses “units” as a universal
measure. When starting a new drawing, AutoCAD provides template files for different measurement
systems. For metric drawings, use the templates with the suffix “ISO”, and for imperial drawings, use
those with the suffix “ANSI”.

You can manage AutoCAD’s default measurement system in the Options dialog:

Click “Options” on the “Tools” menu.
In the Options dialog box, click the “User Preferences” tab.
Under “Default Settings,” click “Default Drawing Units.”
In the Default Drawing Units dialog box, select “Millimeters” or “Inches” as appropriate, then click
OK.

Advanced Tips for Converting Drawings in AutoCAD

While the conversion process is straightforward, working with complex drawings may require some
advanced techniques. For instance:

Batch Conversion: If you have multiple drawings to convert, it might be more efficient to use a
batch conversion tool or script. Some third-party AutoCAD add-ons can automate the process.
Working with Layouts and Viewports: Layouts and viewports can sometimes cause
complications during the conversion process. It’s recommended to switch to model space before
starting the conversion and adjust your layouts and viewports afterward.
Handling External References (Xrefs): If your drawing includes external references, you’ll need
to convert these separately and reload them into the main drawing after conversion.

FAQ

1. Can I convert a drawing from imperial to metric in AutoCAD?

CADDIKT
https://caddikt.com/

https://c
addikt.com/

Page 3
https://caddikt.com/

https://www.autodesk.com/tutorials/autocad
https://www.autodesk.com/tutorials/autocad


Yes, you can also convert an imperial drawing to a metric drawing in AutoCAD. The process is very
similar to what we discussed above, but in reverse. Instead of scaling down your drawing by a factor of
1/25.4, you will scale it up by a factor of 25.4 to account for the fact that 1 inch (imperial unit) is
equivalent to 25.4 millimeters (metric unit). After scaling the drawing, you should use the UNITS
command to update the drawing units to millimeters.

The importance of updating the units lies in ensuring AutoCAD recognizes the conversion. If you fail to
update the units, you may encounter issues in future operations such as dimensioning and scaling. Be
aware that, like with converting from metric to imperial, converting from imperial to metric also scales
everything in your drawing, including text, dimensions, and line thicknesses, so checking your drawing
after conversion is vital.

2. Why do some dimensions seem wrong after conversion?

Sometimes, after converting your drawing from metric to imperial (or vice versa), you might find that
some dimensions do not look correct. This discrepancy is usually due to the original drawing not being
entirely accurate or having been created using a different scale.

In such cases, you might need to manually adjust these dimensions post-conversion. A practical way
to ensure accuracy is to always verify your conversion using a known dimension. That is, if you know a
certain distance should be, say, 10 feet, measure it after the conversion to confirm if it matches the
expected value. If it doesn’t, it may indicate that you need to check your original drawing or reapply the
conversion steps.

3. Can I use the same conversion process for 3D models in AutoCAD?

Yes, the same conversion process applies to both 2D drawings and 3D models in AutoCAD. However,
keep in mind that 3D models contain a third dimension, so all measurements in your model, including
length, width, and height, will be scaled during the conversion process.

It’s crucial to verify the integrity of your 3D models post-conversion. Pay attention to elements such as
text, dimensions, and any associated features that may need to be adjusted separately. If your 3D
model includes hatches, these too will need to be checked for accuracy. Some hatches might not scale
properly and may need to be re-applied after the conversion process.

4. Can I convert a drawing that has both metric and imperial dimensions?

If a drawing has been annotated with dimensions in both metric and imperial units, converting the
drawing might lead to confusion and inaccurate results. Before conversion, it’s best to ensure all
dimensions in your drawing are in the same unit system.

If you do need to convert such a mixed-unit drawing, one approach is to convert all dimensions to a
single unit system (either metric or imperial) before applying the conversion steps. Alternatively, you
could separate the drawing into two – one with metric dimensions and the other with imperial – and
then convert each separately.
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5. Does conversion affect layers in AutoCAD?

The conversion process itself doesn’t directly affect layers in AutoCAD. Layers are primarily
organizational tools that help manage different parts of your drawing and don’t have an inherent unit
system. When you scale a drawing for conversion, all elements, regardless of the layer they’re on, will
be scaled.

However, if you have set up layer properties that depend on units (for example, line thickness), these
will be affected by the conversion. You might need to adjust such layer properties after conversion to
ensure they display correctly in the new unit system.

6. Are there any specific considerations when converting AutoCAD drawings for CNC
machining?

When preparing AutoCAD drawings for CNC (Computer Numerical Control) machining, accurate
dimensions are critical. If you’re converting a drawing from metric to imperial for CNC machining, it’s
crucial to verify the accuracy of your conversion. Any discrepancies could result in manufacturing
errors or parts that don’t fit together as they should.

Additionally, keep in mind that CNC machines may have specific requirements for drawing units, scale,
or format. Always consult your CNC machine’s documentation or manufacturer for specific guidelines
and ensure your converted drawing adheres to these requirements.

7. Is there a difference between converting units in AutoCAD vs AutoCAD LT?

AutoCAD LT is a lighter, more affordable version of AutoCAD, and it provides a similar user experience
and toolset. The process of converting units from metric to imperial (or vice versa) is the same in both
AutoCAD and AutoCAD LT.

However, keep in mind that AutoCAD LT might lack some of the advanced features and capabilities of
full AutoCAD, such as 3D modeling. Therefore, while the conversion process itself will work, you may
not have access to the full range of tools and features in AutoCAD LT to manage your drawing post-
conversion. As always, ensure your software choice aligns with the complexity and requirements of
your projects.

Conclusion

In a globalized world where design collaboration often happens across countries and cultures, the
ability to convert a drawing from one unit system to another is crucial. AutoCAD provides the tools
necessary to accomplish this, and by following the steps outlined in this guide, you should be able to
navigate the conversion process with ease. Remember to always check your drawings after conversion
to ensure the integrity of your design, and don’t hesitate to seek further guidance for advanced
conversion scenarios.

Converting a metric drawing to imperial in AutoCAD is a straightforward process that involves scaling
your drawing and updating the drawing units. With this guide, you should now be able to handle such
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conversions efficiently and accurately. Happy drafting!
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